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Range of alpha particles

Alpha radiation consists of helium nuclei, which are produced during al-
pha decay processes. It belongs to the category of ionizing radiation. Al-
pha particles interact with gas atoms in the air by ionizing them. Through
these collisions with air molecules, the alpha particles lose kinetic energy,
which limits their range in the air. In this experiment, the range of alpha
particles from a radioactive 241Am source in air will be investigated in
two ways.
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1.1 Preparation questions

• What is ionizing radiation? What types of ionizing radiation are there? What dan-
gers are associated with the different types of ionizing radiation? How can one protect
against them?

• What happens during an alpha decay?

• What happens when an alpha particle travels through the air?

• What exactly is meant by the range of an alpha particle? Why is it not infinite?

• How does a semiconductor detector work? What can be measured with it and what
cannot?

• Why is a voltage supply needed in this experiment? What should one bear in mind in
this regard?

• Why is the range of alpha particles not measured in this experiment by simply changing
the distance between the alpha source and the detector at normal pressure?

• What is alpha spectrometry? Where is alpha spectrometry used?

• What is the Bragg curve? Why is the Bragg peak of great importance, for example, in
cancer therapy?

1.2 Theory

1.2.1 Alpha decay

Alpha radiation is a form of ionizing radiation that occurs during alpha decay. A radionuclide
that emits alpha radiation is called an alpha emitter. In an alpha decay, a parent nucleus X with
mass number A and atomic number Z emits an alpha particle, consisting of two neutrons and
two protons. This alpha particle corresponds to a helium nucleus; it has a mass number of
4 and an atomic number of 2. The daughter nucleus Y thus has a mass number reduced by
4 and an atomic number reduced by 2. Additionally, an energy ∆E is released during alpha
decay. In general, an alpha decay can be written as:

A
Z X −→ A−4

Z−2Y + 4
2α + ∆E.

Figure 1.1: In alpha decay, an atomic nucleus emits an alpha particle. This consists of two
protons and two neutrons, corresponding to a helium nucleus. As a result, the original atomic
nucleus has a reduced atomic number by two and a reduced mass number by four. Often,
gamma radiation γ is also emitted during alpha decay.
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The element americium has a mass number of 241 and an atomic number of 95. This means
that an americium nucleus contains 95 protons and 146 neutrons. It is an alpha emitter with a
half-life of 432 years. During an alpha decay, the americium nucleus emits an alpha particle.
What remains is a neptunium nucleus with atomic number 93 and mass number 237. The
alpha decay can be written as:

241
95 Am −→ 237

93 Np + 4
2α + γ59 keV.

1.2.2 Interaction of alpha radiation with matter

The interaction of fast, charged particles such as alpha particles is dominated by electric forces.
The greatest energy transfer occurs through collisions with the electrons of the material. These
collisions excite the atomic electrons to higher energy states. In most cases, a collision between
an alpha particle and an electron in the material transfers enough energy to eject the electron
—- this process is called ionization. The alpha particle loses its kinetic energy mainly through
ionization, i.e., the removal of electrons from atoms. When an alpha particle travels through a
gas, the energy loss per ionization is about 30 eV.

Figure 1.2: An alpha particle (red) ionizes an atom by colliding with an electron. The electron
is ejected from the atom. During each such ionization, the alpha particle loses kinetic energy.
The range of alpha particles depends on the density of the material and the pressure of the
gas.

For alpha particles in a gas, the following holds: the higher the gas pressure, the closer the gas
particles are, and the more collisions an alpha particle will experience while passing through.
These collisions are mostly associated with ionization of gas atoms and reduce the kinetic
energy of the alpha particles, which limits their range in the medium. The range R is defined
as the distance at which the number of alpha particles has been halved (see Figure 1.3).
Even a sheet of paper is sufficient to block alpha radiation. Therefore, the aluminum wall of
the measurement chamber is enough to shield the 241Am source in this experiment.

1.2.3 Semiconductor detector

A semiconductor detector essentially consists of a semiconductor single crystal (gray in Figure
1.4) with a depletion region that can be created in various ways. The depletion region is
an area without free charge carriers. This semiconductor single crystal is located between a
cathode and an anode, and a reverse bias voltage is applied between the two electrodes. This
enlarges the depletion region.
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Figure 1.3: Over a large distance d, the intensity I and thus the number of alpha particles
remains constant. Over a short segment, most alpha particles come to a stop. The range R is
defined as the distance at which the number of alpha particles has dropped to half.

Figure 1.4: A semiconductor detector consists of a semiconductor single crystal without free
charge carriers (shown in gray). It is located between two electrodes — an anode and a cath-
ode. A voltage is applied. When an ionizing particle passes through the detector, it creates
electrons (blue) and holes (red) in the semiconductor. These are accelerated in the electric field
between the electrodes before they can recombine and are thus collected, leading to a measur-
able current pulse proportional to the energy of the incoming ionizing particle.

An ionizing particle, such as an alpha particle, entering the detector generates so-called electron-
hole pairs in the semiconductor’s depletion region. In Figure 1.4, electrons are shown in blue
and holes in red. These are immediately moved and collected toward the corresponding elec-
trode by the electric field, depending on their charge. This gives information about the energy
of the incoming particle. Because the depletion region has a very high electrical resistance and
thus a high electric field strength E is present, the electrons and holes can be collected before
they recombine and annihilate each other.
Semiconductor detectors are the primary choice for spectroscopic applications involving al-
pha and gamma radiation. Due to the direct collection of secondary electron-hole pairs and
the low energy required to produce them (about 3 eV), they offer very high energy resolution.
In this experiment, a silicon single crystal is used, coated with a very thin layer of gold to
minimize the energy loss of the alpha radiation.
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1.2.4 Variance of count rate in a single measurement

When measuring decays from a radioactive source over a time interval with a detector, the
total number of counts is called the accumulated count s. Repeating the measurement usually
yields a different count. Decay processes are statistical in nature. From many identical mea-
surements, a mean count s̄ can be determined. The distribution of such count measurements
over equal time intervals follows a Poisson distribution Π with

Π(s) =
(s̄)s

s!
· e−(s̄).

The standard deviation of a single measurement, and thus its statistical error, is given by

σ =
√

s.

For example, if s = 900 counts are measured in an experiment, then the statistical error of
the measurement is σ = ±30 counts. This means there is a 68% probability that another
measurement with the same duration will fall between 870 and 930 counts. This is because
the measured counts are assumed to be Gaussian-distributed, and the interval of ±σ from the
best value corresponds to the 68% confidence interval (see introduction to error analysis). The
mean relative error σ/s for this measurement is about 3%. For the statistical error of combined
results, the formula for error propagation applies.
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1.3 Experiment

1.3.1 Experimental equipment

The following materials are required for this experiment:

Component Quantity

Measurement chamber with 241Am source 1
Semiconductor detector in measurement chamber 1
Vacuum pump 1
High-voltage power supply 3
Amplifier 1
Computer 1
Manometer 1
BNC cables 5
Rack for modules 1

1.3.2 Measurement chamber with reduced pressure

The experimental setup is shown in Figure 1.5. The vacuum pump is located on the floor
and is connected to the apparatus via a metal hose with a heating sleeve. The measurement
chamber is cube-shaped and mounted externally; inside are the 241Am source and the sili-
con semiconductor detector. The black valve is used to ventilate the vacuum pump, while
the yellow needle valve allows air into the measurement chamber. The passage between the
measurement chamber and the vacuum pump can be opened and closed using the red valves.

Figure 1.5: The round, white manometer shows the air pressure in the vacuum pump. The
pump is located on the floor and is connected to the experimental setup by a hose that runs
up between the tables. The black valve is used to ventilate the pump. The red valves con-
trol the passage between the vacuum pump and the cube-shaped measurement chamber. A
yellow needle valve is used to ventilate the measurement chamber. Inside the chamber are
a radioactive 241Am source and a semiconductor detector. Two measurement chambers are
connected symmetrically so that two groups can conduct the experiment simultaneously and
independently.

In the rack next to the measurement chamber are the high-voltage power supply, the counter,
and an amplifier. A computer with analysis software is connected to the detector. This allows
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spectra to be recorded.

1.3.3 Functionality of the counter

The counter module is brown and located in the rack. The top
part, labeled DISPLAY, shows the number of detected pulses
(or "counts"). However, these pulses are only counted while
the GATE is open. You can tell whether it is open by the red
indicator light —- if no light is illuminated above the word
GATE, then the gate is closed and the counter is off.
The duration for which the gate remains open corresponds
to the measurement time. If, for example, you want to count
pulses over one minute, you must ensure that the gate is
open for one minute. This is set in the middle section of the
counter under TIMER. Two red digits are shown. Use the
button INC M to change the left digit, and INC N to change
the right one. Press each button until the desired digit ap-
pears. DWELL should remain set to OFF. Use the button
TIME BASE SELECT to set the light to 0.1 SEC. The measure-
ment time is then calculated as:

0.1 s · Left digit · 10Right digit.

Use the RESET button to reset the timer to zero. Then start
the measurement with the COUNT button. Once the time
set on the TIMER has elapsed, the gate closes automatically
and the result can be read under DISPLAY. Then press the
STOP button and use RESET to clear the timer again. A new
measurement can be started with COUNT, and so on.

Example: In Figure 1.6, the left digit on the TIMER is 6 and
the right digit is 2. This means the counter is set to a mea-
surement time of:

0.1 s · 6 · 102 = 60 s.

Starting a measurement now will keep the GATE open for ex-
actly 60 seconds. Afterward, you can read how many pulses
were detected during those 60 seconds under DISPLAY.

Figure 1.6: The counter is
located in the rack with the
high-voltage power supply
and amplifier. In the cen-
ter of the counter, a mea-
surement duration can be
preset, during which events
will be counted.
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1.4 Experimental procedure

1.4.1 Before the experiment

Before starting the experiment, familiarize yourself with the setup to prevent damage to the
detector. Proceed as follows:

• Ensure that the high voltage is switched off. Then open the cover on top of the measure-
ment chamber. You should now be able to look through a glass pane into the chamber
(see Figure 1.7). Can you see the semiconductor detector and the radioactive 241Am
source?

• Carefully close the cover again. It is important that the cover always remains closed
while the detector is in operation, i.e., when high voltage is applied. Otherwise, the
detector may be damaged. During the entire experiment, the cover of the measurement
chamber must not be opened again!

Figure 1.7: The silicon semiconductor detector has a circular entrance window. The 241Am
source, which emits alpha particles, is positioned opposite the detector.

Next, follow the instructions precisely to create a vacuum in the measurement chamber and
then start the computer. After that, the system must be calibrated before beginning the mea-
surements.

1.4.2 Creating a vacuum in the measurement chamber

In this experiment, the count rate measured by the semiconductor detector will be investigated
at different air pressures. The air pressure in the measurement chamber can be read using a
digital manometer, shown in Figure 1.8.
To create a vacuum in the measurement chamber, follow these steps:

1. Switch on the digital manometer (see Figure 1.8). The switch is located on the back. This
manometer shows the pressure inside the measurement chamber.

2. Make sure that the black valve for venting the vacuum pump (see Figure 1.9) is closed
(turn clockwise until it is tight).
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Figure 1.8: The manometer shows the air pressure in the vacuum chamber. Ensure that the
unit is displayed in mbar (the bottom right of the display should show ’mbar’). The manome-
ter can be switched on via a switch on the back.

3. Turn the red valve 90◦, pull it out, then turn it another 90◦. This opens the measurement
chamber to the vacuum pump.

Step 1 Step 2 Step 3 Step 4

4. Press the green button on the vacuum pump to turn it on.

5. Watch the digital manometer. Once the desired pressure of p = 0.1 mbar is reached, re-
turn the red valve to its original position: turn it 90◦ back, push it in, and turn it another
90◦. This closes the chamber from the vacuum pump.

Step 1 Step 2 Step 3 Step 4

6. Observe the pressure in the measurement chamber. If it rises sharply, the yellow nee-
dle valve (see Figure 1.11) is not completely closed. Close the needle valve until the
pressure remains approximately constant (important: turning it when it is already fully
closed can damage the needle valve, so stop when the pressure is roughly constant). The
measurement chamber must now be opened again toward the vacuum pump (Step 3)
to reach a lower pressure. Once the desired pressure is reached, it can be closed again
(Step 5).
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7. Press and hold the red button on the vacuum pump until the pump switches off — this
is clearly audible.

8. Vent the pump by opening the black rotary valve (Figure 1.9). Close it again only af-
ter the hissing sound has stopped and the round white manometer shows atmospheric
pressure around p0 = 1013 mbar (compare with the weather station if needed). This
step is essential to prevent oil from being sucked into the pump and causing damage.

Figure 1.9: The black valve used to vent the vacuum pump. Always vent the pump immedi-
ately after use to avoid oil being sucked in.

1.4.3 Switching on the computer

The high voltage must still remain switched off.

1. Turn on the computer. Some computers have a main switch on the back (top left), which
must be flipped on first. For Setup II, start Windows.

2. To log in, use the following credentials:

Setup I (left)
Username install
Password $4onLydS

Setup II (right)
Username radio
Password

Leave the password field blank for Setup II.

3. Start the program InterWinner 5.0, which is located on the desktop.

Instructions for using InterWinner 5.0 are provided in the appendix.

1.4.4 Turning on the detector

After creating a vacuum in the chamber and properly venting the pump, the detector can be
turned on.

1. Make sure the high voltage dial is set to 0.

2. Turn on the main power switch for the rack (front right).

3. Now turn on the high voltage and slowly increase it to the required value. Note that
the left and right chambers require different voltages: one needs 130 V, the other 100 V.
A setting of 1.0 on the scale corresponds to 100 V; 1.3 corresponds to 130 V (see Figure
1.10). The required voltage is labeled on the device.

Do not exceed the specified voltage, and the detector current must not exceed +0.5 µA!
The electronics are optimally configured for this experiment and must not be changed unnec-
essarily.
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Figure 1.10: This rotary switch is used to set the high voltage for the semiconductor detector.
To set 100 V, the top display must show 1 and the dial 0. For 130 V, the top must show 1 and
the dial 30. When switching on or off, both should be set to 0 as shown.

1.4.5 Calibration

First, the system must be calibrated. This involves assigning an energy to the channels. Pro-
ceed as follows:

1. Click the orange traffic light to clear the current spectrum.

2. Click the green traffic light to start a new measurement. The measurement should run
for at least 100 seconds.

3. Then click the red traffic light to stop the measurement.

4. Locate the peak with the highest intensity and mark it. To do this, place the cursor at the
beginning of the desired peak and hold down the SHIFT key. The cursor will turn into
a pencil, which you can move with the mouse. Mark the full width of the peak before
releasing the SHIFT key.

5. A window will pop up allowing you to choose any color to mark the peak. The peak
will then be highlighted in the selected color.

6. At the top menu, click Edit, then select Calibration and choose Energy/Resolution. A win-
dow will open displaying the spectrum just recorded.

7. In the spectrum, click on the small colored square located at the maximum of the previ-
ously marked peak along the x-axis. From the context menu, select Select manually and
enter the reference energy value for the alpha particles: 5486 keV.

8. Confirm with OK and OK.

9. Finally, save the spectrum by clicking File > Save as in the top-left menu and choose a
clear and unique filename. Take a picture of the calibration curve with your cell phone
for the report.

With this calibration, you have informed the system that the 241Am peak lies at an energy of
5486 keV. You are now ready to begin the measurements.
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1.4.6 Measurements

A pre-formatted table for recording the measurement values is provided in the appendix.
Enter the measured values into the gray-highlighted columns. The remaining fields will be
calculated later during the analysis. Read the air pressure p0 in the lab room from the weather
station.
Click the orange traffic light to clear the spectrum. The calibration will remain unaffected. You
can now begin the actual measurements.

1. Read the pressure in the measurement chamber from the digital manometer and enter it
into the column Pressure p in the table.

2. Set the timer on the counter (located next to the high voltage module in the rack) to 100
seconds. Then start the counter by pressing the COUNT button.

3. At the same time, start the recording of a spectrum by pressing the green traffic light.
The measurement time should also be 100 seconds. The two measurements can run
simultaneously.

4. After the measurement period, read the value on the counter display under DISPLAY
and enter it into the column Pulse Count in the table.

5. After 100 seconds, stop the spectrum acquisition by clicking the red traffic light. Read the
energy at the maximum of the newly recorded peak and enter this value in the column
Deposited Energy Eα in the table. Determine the full width at half maximum (FWHM)
of the peak in order to estimate the statistical error of the measurement. Depending on
the size of the peak, in the software Interwinner 5.0 under Peaksearch with Analysis, the
maximum amplitude and the full width at half maximum can be determined directly.
Otherwise, they must be estimated from the graph.

6. Slightly open the yellow needle valve (figure 1.11) and observe the digital manometer.
Begin closing the needle valve before the next desired pressure level is reached.

Figure 1.11: Important: A needle valve must not be tightened like a water tap! As soon as you
feel little resistance while turning and the pressure on the digital manometer remains stable,
the valve is closed. Further tightening can damage the needle valve.

Consider how large the systematic and statistical errors are for the lab pressure p0, the pressure
p, the count rate, and the deposited energy Eα, and write them down.
Repeat these steps for 100 mbar, 200 mbar, 300 mbar, 400 mbar, 420 mbar, 430 mbar, 440 mbar,
445 mbar, 450 mbar, 455 mbar, and 460 mbar inside the measurement chamber. Use the nee-
dle valve to adjust the chamber pressure and reset the counter before each new measurement
using STOP and RESET. In total, you should have filled in all twelve rows of the table. If you
want, you can save the spectra.
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1.4.7 After the experiment

1. Slowly turn the high voltage control knob back to zero.

2. Switch off the high voltage module, followed by the main switch of the rack.

3. Vent the measurement chamber by opening the yellow needle valve. This ensures that
the detector is shielded from alpha particles by a sufficient air layer. Otherwise, the
detector would be continuously bombarded by alpha particles and would have a very
short lifespan.

4. If desired, the stored spectra can be transferred using a USB stick or a floppy disk, de-
pending on the setup. However, for the report, a cell phone photo of the calibration
curve and the recorded measurement values for the deposited energy Eα and the FWHM
are sufficient.

5. Switch off the digital manometer using the switch on the back of the device.

6. Shut down the computer. If present, also turn off the main power switch on the back of
the computer.

7. Wash your hands thoroughly.

1.5 Analysis

Complete the following tasks for the analysis and document your procedure and results in
your lab report.

1. Examine the calibration spectrum. Describe this spectrum — what stands out to you? If
you observe multiple peaks, explain their origin.

2. Calculate the count rate s for each of the recorded counts measured over 100 seconds,
i.e., the number of counts per second. Enter the values in the table.

3. The virtual distance d can be calculated as:

d = d0 ·
p

p0
.

Here, d0 = 89.5 mm is the distance between the 241Am source and the detector, and p0 is
the air pressure in the lab at the time of the experiment. The pressure p is the respective
pressure in the measurement chamber.

4. Plot a diagram with the virtual distance d on the horizontal axis and the count rate s on
the vertical axis. Both quantities should include error bars, which are to be explained in
the report.

5. Use this diagram to estimate the range of alpha particles in air. Estimate an uncertainty
for the range of the alpha particles and justify your error estimation. Why is the range
an important quantity in radiation protection?

6. Determine the energy difference ∆Eα between the two main peaks in the 241Am spectrum
of each pair of successive measurements, in the unit keV. Enter the values in the table.

7. Calculate the change in virtual distance ∆x between each pair of successive measure-
ments. Fill in these values in the table.
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8. Why is a virtual distance used in this experiment? Why not simply change the physical
distance between the source and the detector?

9. Calculate the average energy loss per path length ∆Eα/∆x in keV/mm and enter these
values in the table as well.

10. Calculate the mean virtual distance d̄ of to successive measurements and fill these values
in the table.

11. Plot a diagram with the mean virtual distance d̄ on the horizontal axis and the average
energy loss per path length ∆Eα/∆x on the vertical axis. This curve is known as the Bragg
curve, named after the English Nobel Prize-winning physicist William Henry Bragg.

12. Again, include error bars for all measurement points and explain how you calculate
them.

13. Where is the Bragg peak located? What can be said about the energy deposited per unit
length at the Bragg peak?

14. Estimate an uncertainty for the the position of the Bragg peak. Justify your error estima-
tion.

15. Why is knowledge of the Bragg peak of exceptional importance in radiation therapy for
cancer patients?

16. How is the Bragg peak related to the range of the alpha particles? Compare the range
diagram with the Bragg curve.

1.6 Literature

• B. Povh, Kerne und Teilchen, Springer Verlag, 2013

• T. Meyer Kuckuck, Kernphysik, Springer Verlag, 1979

• H. Kolanoski, N. Wermes, Teilchendetektoren, Springer Verlag, 2016

Information on radioactivity and radiation protection can be found on the lab course website.
It is recommended to study these materials thoroughly in advance.
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Appendix

A.1 InterWinner 5.0

The spectra are recorded using the software InterWinner 5.0. Some useful commands and
functions are summarized below.

A.1.1 Recording and managing spectra

Start InterWinner 5.0 Click the icon on the desktop. Alternatively, go to Start > Inter-
Winner 5.0 and click on InterWinner

Start measurement Click the green traffic light or press the F2 key
Stop measurement Click the red traffic light or press the F3 key
Delete measurement Click the orange traffic light or press the F4 key
Scale Y-axis Place the cursor on the spectrum, right-click, and select Y scale
Scale X-axis Press F9 to zoom in, F10 to zoom out
Zoom into region Hold the cursor on the spectrum and press the left mouse button
Save spectra In the top-left menu, click File > Save as
Load spectra In the top-left menu, click File > Open and select the desired spec-

trum
Analysis Click on Edit > Analysis; a report window will open
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A.2 Measurement protocol: alpha particle range Air pressure in the lab p0 =

It is recommended to take measurements in the chamber at the following pressure values: 0.1 mbar, 100 mbar, 200 mbar, 300 mbar, 400 mbar,
420 mbar, 430 mbar, 440 mbar, 445 mbar, 450 mbar, 455 mbar, and 460 mbar. Gray: measure, white: calculate.

Pressure p Virtual
distance d

Pulse
count

Pulse rate
s

Deposited
energy Eα

FWHM of
Eα

(= 2.35 · σ)

Energy
difference

∆Eα

Distance
change ∆x

Energy
loss

∆Eα/∆x

Mean
virtual

distance d̄

[mbar] [mm] [per 100s] [s−1] [keV] [keV] [keV] [mm] [keV/mm] [mm]

17


	Preparation questions
	Theory
	Alpha decay
	Interaction of alpha radiation with matter
	Semiconductor detector
	Variance of count rate in a single measurement


	Experiment
	Experimental equipment
	Measurement chamber with reduced pressure
	Functionality of the counter

	Experimental procedure
	Before the experiment
	Creating a vacuum in the measurement chamber
	Switching on the computer
	Turning on the detector
	Calibration
	Measurements
	After the experiment

	Analysis
	Literature
	InterWinner 5.0
	Recording and managing spectra

	Measurement protocol: alpha particle range

